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1 Introduction

1.1 How to Use This Guide

The goal of the NetBurner Eclipse Getting Started Guide is to familiarize new users with the NetBurner Eclipse
(NBEclipse) interface and basic operation. NBEclipse is based on the standard Eclipse release with additional
features to support development with NetBurner hardware, such as application downloads to flash memory and the
ability to locate NetBurner hardware on a network. It will provide a general overview of how NBEclipse works and
provide details on the following:

e How to create a new project

e Import, compile, and execute example programs

e Debug an example program

e  Use the application wizard to create a new program

e Various tips on useful features of the NBEclipse environment

1.2 Source Code for Example Programs

Source code for the examples in this document are located in the \nburn\examples directory of your NetBurner
tools installation. General examples for products using the standard stack are located in
\nburn\examples\StandardStack.

1.3 Hardware Setup

This document assumes you have a working hardware platform on which you can run the examples. Your
NetBurner development kit hardware is pre-programmed with an example application at the factory. Before
executing the examples in this document, it would be a good idea to connect your NetBurner device to your
computer and verify you have serial and network communication with the device as described in the NNDK Quick
Start Guide.

1.4 Network versus Non-Network Platforms

Throughout this document, there will be references to network and non-network platforms. The NetBurner tools
separate the two platform categories by placing system files in separate directories. The "nn" suffix is used to
represent non-network code. For example, include files are stored in \nburn\include and
\nburn\include nn, while system files are stored in \nburn\system and \nburn\system nn. You
may have one or both of these directory sets depending on the NetBurner platforms purchased and installed on your
computer.

1.5 Software Installation

The NetBurner software tools run on Microsoft Windows Vista and later, and are available for download by
following the steps outlined at http://www.netburner.com/support/get-tools. Please note that a registered NetBurner
support account will be required to access the download. After downloading the NNDK Software, run the setup
application and follow the onscreen directions to install the NNDK.

NetBurner Eclipse Getting Started Guide Page 3


http://www.netburner.com/support/get-tools

1.5.1 Upgrading From a Previous Installation

Do not install over an existing version when upgrading from a previous version of the NetBurner tools. The upgrade
requires that you either rename or uninstall the existing installation directory. The recommended procedure is as
follows:

1. Backup any existing projects you want to save, especially if they are in the NetBurner tools
installation directory.

2. Rename the existing tools installation folder. For example, rename C: \nburn to C: \nburnVerX, where
‘X’ is the previous version number. You can always get back to the previous installation by renaming the
directory back to the original name this way.

3. Run the installation for the new tools.

1.5.2 Java Installation

NBEclipse requires the 32-bit Java Runtime Environment (JRE) revision 1.6 or higher. If there is no JRE installed,
then you will receive an error message when starting NBEclipse stating that it cannot find the JRE executable. The
JRE is free from http://java.sun.com. Download either the Java SE (Standard Edition) Development Kit (JDK) or
Runtime Environment and follow the installation prompts. You may need to restart your computer after installation
is complete.

1.6 Debug Port

Throughout this guide, we will refer to the "serial debug port". The serial debug port is one of the RS-232 ports that
can be used to interact with your NetBurner device in the example programs. Stdout, stdin, and stderr are mapped to
the debug port by default, so when you use functions like printf (), scanf (), gets (), they read and write to
the serial debug port. Mapping of the stdio is configurable, as you can disable the serial debug port and use it as a
general purpose UART, or reassign the stdio file descriptors to use other serial or network interfaces. Debugging in
NBEclipse on network-enabled platforms will occur through the Ethernet connection, while debugging on non-
network platforms will use the serial port.
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2 Overview of the NetBurner Development Platforms

Your NetBurner Network Development Kit provides two options for development:

e  GNU make utility via Windows command line
o NBEclipse Integrated Development Environment (IDE)

The choice of what platform you wish to use depends on personal preferences. The command line tools use
makefiles familiar to development on Unix and Linux environments. This make utility can also be invoked from
within other IDEs and code editors such as SlickEdit.

NBEclipse is an enterprise level professional IDE that provides editing, downloading, and debugging in one
package. NBEclipse was designed to be extensible to any number of platforms and programming languages, and as
a consequence it has more features than most people will probably ever use. However, most people find that it
quickly becomes their IDE of choice after spending a little time learning the environment. NBEclipse has the
capability to add plug-ins for additional features. For example, there is a SlickEdit plug-in for those who prefer to
use that editor.

3 The NBEclipse Project Manager

The following points are useful to users who have not used a similar type of project manager. There are three main
ways to maintain and build a project:

1. Use NBEclipse to manage the project with the project files located in the NBEclipse workspace. This is the
recommended method.

2. Use NBEclipse to manage the project with the project files located in an existing directory outside the
NBECclipse workspace.

3. Configure NBEclipse to use an external makefile that you maintain.

Those new to the Eclipse IDE may find the following operation different from previous development environments.
A summary of these differences are listed below and each will be covered in detail in the following sections:

1. NBEclipse will default to a compile mode of "Build Automatically" that will compile the source code each
time a source code file is saved. Most people find it to be a very useful feature once they get used to it,
however, it can be disabled from the main menu by selecting:

Project » Build Automatically

N

NBEclipse uses a "workspace" in which projects are created and source files are copied.

3. All recognized files in a project directory will be compiled. Recognized files have extensions of . c, . cpp,
and . s (. s is an assembly language file).

4. A "Run" configuration must be created for each project in order to download the application image to your
NetBurner target.

5. The "Project Explorer" tab on the left side of the NBEclipse IDE is a navigation window just like Windows
Explorer — it is not a file project manager. All recognized files are built as stated in item (3) above. If you
have non-project related files in your project directory and wish to see only the project files in the tab, you
can select a filter to display only source code files.

6. Application build output files such as .o, .elf, .map, and .s19 files will be written to project

subdirectories named Release and Debug that correspond to the type of build executed.
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Keep in mind that NBEclipse is a project-based (IDE) tool; it is not intended to be a general purpose editor for
quickly opening source code files from Windows Explorer by double-clicking on them. You have the option of
using various code editors such as SlickEdit or Notepad++ for quick viewing of the source files. Of course, you can
view any file with NBEclipse, but to effectively use the IDE, you must first create a project, and then import files
into the project space.

The NBEclipse executable is located in \nburn\NBEclipse on Windows, and in the Applications folder on OSX.

3.1 The NBEclipse Workspace

Projects are created in the NBEclipse "workspace”. The default location is located in the directory
\nburn\workspace. Project files, source code files, and web page files will all be created or imported to a designated
project directory within the workspace.

When building an example program we recommend using the project import feature for the source files. This will
create a copy of the source files in your workspace and leave the original files intact.

Locating the workspace in the default location has the advantage that the tools, libraries and your source code are
kept together in the \nburn directory. If you upgrade your tools in the future you can rename your current \nburn
directory to something meaningful (eg nburn2p7p7), perform a clean installation of the new tools to \nburn, and

import your projects. If you ever need to go back to a previous revision you can rename the directory back to \nburn
and you will have the entire environment back.

3.2 Sharing Projects Using Different Operating Systems

If there are multiple developers working on the same project source code, but developing on different operating
systems such as Windows and OSX, you must be sure to only share the project source code files. The Eclipse
project management files are specific to the operating system. These files/folders are: .metadata, .setting, .cproject,
and .project. When using version control system be sure not to check in these files/folders.

3.3 Excluding Files From a Project
You can prevent Eclipse from trying to build specific files by right-clicking on the file and selecting

Resource Configurations > Exclude From Build.

3.4 Auto Completion

When writing code in the editor, pressing cntl + spacebar will invoke the auto-complete feature.

NetBurner Eclipse Getting Started Guide Page 6



4 Creating a Project for a NetBurner Example Application

This section will provide step-by-step instructions on how to create an NBEclipse project from a NetBurner example
application. These steps can be used to import any existing projects. A summary of the steps required are:

e Create an empty NBEclipse project
e Import the source files from the NetBurner example folder
e Build the application and load it into a NetBurner device

NetBurner provides both network-enabled and non-network hardware platforms. We will cover one of each type in
this section: the Mod5213 (non-network) and the Mod5441X (network-enabled). The platform choices only affect
the NetBurner example chosen in the import process. If you are using a different NetBurner hardware device you
can select a different example application.

4.1 Creating an NBEclipse Empty Project

The first step is to create an NBEclipse project. The project will store the settings to build the application and
manage the build process. We can import the source code files from the example once the project is created. From
the NBEclipse main menu, select:

File » New » Project...

}‘ MetBurner - MEEclipse IDE - Release 2.8.2

File Edit Mavigate Search Project MNEBEclipse Run  Window Help

Mew Alt+Shift+M > 7 Project... (s -
e F4 Other..  Ctrl+N

Close Ctrl+W

Close All Ctrl+ Shift+W

Save Ctrl+5

Save Az

Save All Ctrl+Shift+5

Revert
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The "New Project" dialog box will appear.

There are various options available, but the only valid options for

development on your NetBurner device are under the "NetBurner" folder. Choosing anything under "C" or "C++"
will not generate a compatible project for your NetBurner platform. Select “NetBurner Project” to continue.

‘;'V‘ Mew Project

Select a wizard

Wizards:

= General

= CfC++

= MetBurner
MetBurner Project

< Back

Finish Cancel
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Clicking "Next" will bring up the "C++ Project" dialog box. In the image below, we have typed in the project name

"Mod5441xFactoryApp" because that is the name of the example application we will import. The "User default

checkbox tells NBEclipse to locate the project in the default workspace, so a folder named "Mod5441xFactoryApp"
will be created in the workspace folder. This is where the project files, source files, and compiled images will reside.

\-'*1 C++ Project

C++ Project
Create C++ project of selected type

Project name: | Mod34d1xFactoryApp

Uze default location

Dvnburn\workspace\Mod3441xFactoryApp

Project type: Toolchains:

Browse...

<» MetBurner Device Executable
<» MetBurner Device Library
= Makefile project

MetBurner Device

@j < Back MNext =

Finish

Show project types and toclchains only if they are supported on the platform

Cancel

Now we will choose the "Next" button to explore all the possible settings.

It is recommended that you always go

through all the option screens; one of which is the hardware platform selection. This is particularly important if you

have more than one NetBurner hardware platform installed.
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Clicking "Next" displays the configurations options page. We want to be able to build both release and debug builds,
so leave both checkboxes checked in the configuration section as shown below.

' C++ Project O >

Select Configqurations

Select platforms and configurations you wish to deploy on [

Project type: MetBurner Device Executable
Teeolchains: MetBurner Device

Configurations:

E83 Release

Select all
s Debug

Deselect all

Advanced settings...

Use "Advanced settings” button to edit project’s properties,

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.

. -
@_,J < Back _ MNext = Finizh Cancel
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Clicking "Next" displays the "NetBurner Platform Options" dialog box. You must select a target platform to
continue. If your device is already plugged in and running on your network, you can click search to bring up a list of
NetBurner modules on your network.

If your device is a non-network device, you only need to supply the Target Platform. If your device is network
enabled, it is recommended that you input your device IP address, as it will save you from having to input it when
you want to update your board.

#' C++ Project O =
NetBurner Flatform Options —
Set the platform cptions for the new MetBurner project.
Platform Cenfiguration Opticns
A platform must be selected to finish this wizard.
Device Select (Autofill): Search
Target Platform: | MOD5441% V|
IP Address: [10.1.1.86 |
@:l < Back Mext = Einish Cancel

NetBurner Eclipse Getting Started Guide Page 11



Clicking "Next" displays the "NetBurner Project Options" dialog box. We do not want to select any of the
"NetBurner Application Wizard" checkboxes since we intend to import existing application source files. If we do,
then amain. cpp file will be created with the selected options. If the intent was to create a new application with
the application wizard, then we would have followed the same steps to this point and selected the desired options.

' C++ Project O by

MetBurner Project Options —

Set the various options for the new NetBurner project.

MetBurner Application Wizard

If you would like MBEclipse to generate your project, please select your configuration ¢
Mot all options are avaiable for every platform

Options

[] AutoUpdate []SmartTrap
SerialLoad WiFi

[]DHCP [ ] Network Debugging

[ WebServer Serial Debugging

[] TaskScan
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When we click on the "Finish" button, we will have created a new project. Since we did not select any application
wizard project options, this is actually a blank project — meaning it does not have any source code files attached to it.
A screenshot of the blank project is shown below. An outline is not available because the source code files have not
yet been imported into the project.

¥ NetBurner - NBEclipse IDE - Release 2.7.6 - o X
File Edit MNovigate Search Project NBEclipse Run Window Help
wifhd & e/ Bl gra-E-re@r H-0~ &~ TH-e e
[ & NetBurner
[ Project Explorer £1 =8 = B || B Outline 12 =g
S=Y - An outline is not available.

=% Mod5441xFactoryApp

7 NEFind 2| ¥ NBConfig & = 0|/ B Console &2 |[2 Problems | ¥ Tasks G E TR =
Platform 1P Address MAC Address Application CDT Build Console [Mod5441xFactoryApp]
[E mopsaaix 101170 00-03-F4-07-5D-2B  nnn . . .
= seLze 10411195 - DHCP 00-03-F4-03-93-3 A2DWeb w«w* Rebuild of configuration Release for project ModS441xFactoryApp ****
IEl MOD5441X 10.1.1.86 - DHCP 00-03-F4-0A-01-B9 AppWizard ##%% Invernal Builder is used for build .
Nothing to build for ModS5441xFactoryApp
i =5 Mod3441xFactoryApp
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4.2 Importing Source Code Files into an Existing Project

Now that we have created a project, let’s import the "Mod5441xFactoryApp™ example source code files into the
project. To import files, right-click on the "Mod5441xFactoryApp" project in the "Project Explorer" window on the
left side of the screen, and then select Import. .. from the pop-up menu. You will then see the menu shown

below.

i
=% Mod=
i
4y
[T
-
L

NetBurner Eclipse Getting Started Guide

‘-'*1 MetBurner - MBEclipse IDE - Release 2.7.6
File Edit Mavigate Search Project MEBEclipse

Run

& w2 Y e B

E %5 Debug [ NetBurner
[ Project Explorer &3 o) 5 7 = O

Mew

Go Into

Open in New Window

Copy
Paste

Delete
Source
Maove...

Rename...

Import...
Export...

Build Project
Clean Project
Refresh

Close Project

Close Unrelated Projects

Ctrl+C
Ctrl+V
Delete

F2

F5

Window
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Clicking on Import. .. will display the dialog box shown below. We want to import source code files from the
"Mod5441xFactoryApp" example, so select:

General » File System

Then click on the "Next" button. The other options in this dialog box will not be used with your NetBurner tools.

' Import O =
Select
E\J ]
Import resources from the local file systern inte an existing project.

Select an import source:

type filter text

w [ General

@j Archive File
123 Existing Projects into Workspace
[, File System
E|, Preferences

= C/C++

[= Run/Debug

= Teamn

@ < Back Next > Finish Cancel
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Now we need to select the files to import. Click the "Browse..." button and navigate to the "Mod5441x-
FactoryApp" example source files located in \nburn\examples\Mod5270\Mod5441x-FactoryApp. The
directory and file selector dialog box will appear and provide checkboxes to enable you to select which source files

to import into the project.

#" Import O >
File system —
Source must not be empty. B
<
From directory: ~ | Browse...
Filter Types... Select All Deselect All
Into folder: | Mod3dd xFactoryApp Browse...
Opticns
] Overwrite existing resources without warning
[] Create top-level folder
Advanced ==
@ < Back Next » Finish Cancel
Page 16
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If you cannot see the html folder in the left hand window, click on the ">' sign next to the MOD5441x-
FactoryApp folder to expand it. No files have been selected at this point. Filters can be used for automatic
selection, but in this example, we will click on each box individually to select the files. We will be selecting all files
with extensions of . c, .cpp, and .h.

# Import O >
File system —
€3 There are no resources currently selected for import. B
-
From directory: | C:\nburm'examples\MOD5441X\MOD5441x-FactoryApp v|  Browse.
v []= MOD5441x-Factoryhpp 1 [c ftps.cpp
(] &= html (] [g main.cpp
] | @ makefile
(] [l SimpleAD.cpp
(] [ SimpleAD.h

O [e webfuncs.cpp
] [£] webfuncs.h

Filter Types... Select All Deselect All
Into folder: | Mod3dd xFactoryApp Browse...
Options

[ ] Qverwrite existing resources without warning

[ ]Create top-level folder

Advanced »»

@ < Back Next > Finish Cancel
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Click the box next to the htm1l folder in the left window so we can include the folder and all of its contents, and
then select the following files in the right window:

e ftps.cpp (support for FTP server)

e main.cpp

e webfuncs.cpp/.h (contains the dynamic web page functions)
e SimpleAD.cpp/.h

The dialog box with these selections is shown below:

#" Import O x
File system —
Import resources from the local file system. li ,._f
-
From directory: | C:\nburn\examples\MODS5441X\MOD5441x-FactoryApp v||  Browse.
[m] (= MOD5344x-FactoryApp _
= html €] main.cpp
] | @ makefile

€] SimpleAD.cpp
€] SimpleAD.h
[£] webfuncs.cpp
@webfuncs.h

Filter Types... Select All Deselect All
Into folder: | Mod3dd xFactoryApp Browse...
Options

[ ] Overwrite existing resources without warning

[]Create top-level folder

Advanced ==

You will be taken back to the NBEclipse IDE when you click "Finish” to complete the import, and the application
will automatically begin compilation. To build the application in the future, select the pull down option:

Project » Build Project
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Clicking on the ">'sign next to Mod5441xFactoryApp followed by double-clicking on the main . cpp file name

in the "Project Explorer” window will open it for editing. The screen shot below shows a successful build as shown
in the "Console" tab window in the lower-right corner.

" NetBurner - NBElipse IDE - Release 2.7.6
File Edit MNavigate Search Project NBEcipse Run Window Help
E @i |V ABaw® g @ -0 - kD G- -

EY © NetBurner
[ Project Explorer &1 =0 = 0| 5= outline 2 =g
=K} An outline is not available.

v 125 Mod5441xFactoryApp

4, Binaries

) Includes

(= html

(= Release

l< ftps.cop

[g main.cpp

[@ SimpleAD.cpp

SimpleAD.h

[@ webfuncs.cpp

webfuncsh

# NBFind I3 | # NBConfig » = 8| E Console 2 |2 Problems | ¥ Tasks O 45| B tE8~-i-=0

Platform IP Address MAC Address Application CDT Build Console [Mod5441xFactoryApp]
[El mopsaaix 104170 00-03-F4-07-5D-28  nnn Used 191313 bytes of 3329 available flash (0.57%) "
[E] saLe 1011195 -DHCP  00-03-F4-03-93-3F  A2DWeb Used 951448 bytes of 67108085 available ram (1.42%)
[E] MoD3441X 101,186 - DHCP 00-03-F4-0A-01-B9  AppWizard

NNDE release tag version:2.7.6

Build complete for project ModS44lxFactoryRpp
Time consumed: 1664 ms.

S Mod5441xFactorylpp

At this point, you have a project complete with source code files. You can use the editor to modify the files, and the
compiler will automatically build the project when you save the file. Any errors or warnings will be displayed in the
"Problems" tab, and compiler output will be displayed in the "Console™" tab.

Now that we can build the project, the next step is to download the compiled image into the NetBurner hardware by
creating a "Run" configuration.
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5 Downloading Applications to NetBurner Hardware - Creating
"Run" and "Debug" Configurations

Up to this point, we have created a project, imported C/C++ and HTML source code files, and have compiled the
source code files into an application image. The next step is to download and run the application image into the
NetBurner hardware. To accomplish this task, we need to create a "Run" configuration for the project that identifies
the target NetBurner hardware. You will normally create the "Debug" configuration at the same time, which enables
you to download and run the application in the NBEclipse debugger.

5.1.1 Application File Types and Locations

Each time an application is built as a "Release", two files are created: one is mapped for execution in RAM with an
extension of .s19, and the other is compressed and mapped for storage in flash memory with an extension of
_APP.s19. These files are stored in your project directory in a folder named Release. The files are located in
\nburn\NBEclipse\workspace\Mod5441xFactoryApp\Release in our example. The "Release" is
the optimized build intended for your product release. In comparison, a "Debug" build turns optimization off and is
intended for use with the NBEclipse debugger. The application files follow the same naming format as the Release
build with a DB prefix and are stored in a project subdirectory named Debug. An example of file names for the
"Mod5441xFactoryApp" project are:

e Mod54415FactoryDemo.s19, release build mapped for SDRAM

e Mod54415FactoryDemo APP.s19, release build mapped for flash

e DBModb54415FactoryDemo.s19, debug build mapped for SDRAM

e DBMod54415FactoryDemo APP.s19, debug build mapped for flash

You do not need to worry about these file locations or extensions when using NBEclipse for code development. The
application download from within NBEclipse will automatically use the compressed flash image and download it to
your NetBurner hardware for both "Release” and "Debug" builds. If you wish to use the builds mapped for
SDRAM, then you will need to manually download them by using the DL command at the nb> prompt through the
MTTTY serial terminal to the NetBurner device.

5.1.2 Auto Creating an NBEclipse Run/Debug Configuration

If you have a network enabled NetBurner device, the easiest way to create a run configuration is to allow NBEclipse
to automatically create your run configuration. To automatically create a run configuration, click on your project in
the “Project Explorer” window. Once selected, simply click on the “Run” button (a white play in a green circle).
Your project will automatically be compiled, built and loaded onto your board. Creating debug configuration works
much the same. Click on your project in the “Project Explorer” window. Once selected, simply click on the “Debug”
button (a green bug). This will compile, build, load and connect the debugger to your device.

5.1.3 Creating a NBEclipse Run Configuration

To create a "Run™ configuration we will use the "Run" combo box on the NBEclipse tool bar. There are two
components to the "Run" button icon: a green-filled circle with a white triangle within pointing to the right, and a
small black triangle pointing down next to the green circle icon. Selecting the small black triangle drops down a
menu with "Run" configuration options. Selecting the green circle icon will replay the previous "Run"
configuration. Once you have created a "Run" configuration, you can simply click on the green circle icon during
development to quickly download the application to your NetBurner hardware. You must create a separate "Run"
configuration for each project.
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Options will vary slightly between network and non-network NetBurner target platforms. These differences will be
explained by notes where appropriate.

Let’s start by creating a new "Run" configuration. Click on the small black triangle to display the drop-down menu
and select Run Configurations.. as shown in the image below.

# NetBurner - NEElipse DE - Release 2.7.6

- [m] X
File Edit Mavigate Search Project NBEclpse Run Window Help
[wilhd [ i@ EFMaw® Gra- - -0 7 ~El s
[ NetBurner (no launch history)
[ Project Explorer £ =8 Run As > = O || 8= Outline 22 =0

B%~ Run Configurations... An outline is not available.

Organize Favorites.

v 15 Mod5441xFactoryApp
45 Binaries
[ Includes
& html
[ Release
[€] ftps.cpp
[ main.cpp
(€] SimpleAD.cpp
[8 SimpleAD.h
€] webfuncs.cpp
6 webfuncs.h

% NBFind £2 | ' NBConfig

4 = 0|/ B console 23 | [El Problems| &] Tasks O G| #B-5-=0
Platform 1P Address MAC Address Application B —
E MOD5441% 10.1.1.70 00-03-F4-07-5D-28 nnn Used 191313 bytes of 33 8 available flash (0.57%) "
ESBLZE 10.1.1.193 - DHCP 00-03-F4-03-93-3F A2DWeb Used 951448 bytes of 6710 5 available ram (1.42%)
E MOD3441X 10.1.1.86 - DHCP 00-03-F4-0A-01-8% AppWizard NNDE release tag version:2.7.6
Build complete for project ModS441xFactoryApp
Time consumed: 1664 ms3.
v
-

=5 Mod3441xFactoryApp
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The "Create, mange and run configurations” dialog box will appear. The only option we will use on the left side of
the dialog box is the "NetBurner Launcher”. Select "NetBurner Launcher" and then click on the "New launch
configuration™ icon. This icon is at the top-leftmost corner and is shown as what appears to be a white rectangular
paper with a small yellow '+' sign at its upper-right corner.

f‘ Run Configurations X

Create. manage, and run configurations —

W

@I | = v Configure launch settings from this dialog:
type filter text % - Press the 'New' button to create a configuration of the selected type.
[E] C/C++ Application =| - Press the 'Duplicate’ button to copy the selected configuration.

@ Launch Group

MetBurner Launcher ¥ - Press the 'Delete’ button to remove the selected configuration.

::=:D - Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the 'Perspectives’ preference page.

Filter matched 3 of 9 items

) Run Close
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The configuration options are shown below, with the "Project” tab already selected. The "Name" and "Project"
textbox fields should already be filled in with the name of the project that we currently have open. If either or both
fields are empty, then enter the project name that this "Run" configuration is intended for — in our example, this
would be the "Mod5441xFactoryApp™.

Network platforms: If you are using a network-enabled NetBurner hardware platform, click on the "Search™ button
next to the "Target IP" field and select your NetBurner device from the list. If you do not see your device in the list,
then check your hardware setup and click on "Search" again. A target IP address is required for network platforms.
If you still cannot find your NetBurner device with the "Search" button, please refer to the “Quick Start Guide” that
came with your development Kit.

Non-network platforms: If you are using a non-network hardware platform, then leave the "Target IP" field blank.

\-3' Run Configurations X
Create. manage. and run configurations ;—I
5 —*,
TE X | = Mame: | Mod5441xFactoryfpp |
type filter text Project | 9= Arguments | g Environment | %% Debugger| & Source| = Common
[©] C/C++ Application Paet
@ Launch Group
W MetBurner Launcher | Mod5441xFactoryfpp | Browse
Meod3441xFactoryd Target IP:
| 10.1.1.86 || Search
< >
. . Apply Revert
Filter matched 4 of 9 items
ey

Now click on the "Debugger" tab.
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Network platforms:

e Check to make sure "NetBurner Standard Debugger" is selected in the "Debugger" listbox, and then select
the "Connection" tab in the "Debugger Options" section.
Select "TCP" in the "Type" listbox if it isn't selected already.
Use the target IP address entered in the "Project” tab for the "Host name or IP address" textbox.

e The "Port Number" textbox value should be preset to "2159".

" Run Configurations >
Create. manage. and run configurations @
= =ik o
[T =2 % | = MName: | Mod35441xFactoryApp |
type filter text Project | (9= Arguments | 7§ Environment l#@« Dehugger] |73 Sourcel ==| Qommonl
[T] C/C++ Application
# Launch Group Debugger: | MetBurner Standard Debugger ~
v MetBurner Launcher
Mod544 1xFactary! [Jstop enstartup at  main Advanced...
Debugger Options
Main  Extra Connection
Type: | TCP ~
Host name or [P address: | 10.1.1.86
Port number: 2159
- - Appl R
evert
Filter matched 4 of 9 items PR —
@
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Non-network platforms:

e Select "Speed Serial" in the "Type" listbox under the "Connection" tab. This will provide the fastest serial
debugging connection. In order to use speed serial, you will need to start the NetBurner "Speed Serial
Debug" utility. This utility communicates with NBEclipse through a loopback network connection and
port number, which in turn communicates with the NetBurner target hardware through the PC serial port.

e Leave the "Host name or IP address" field set to the default loopback address of "127.0.0.1".

e Leave the "Port number" field set to the default port of "2159",

e When running the "Speed Serial Debug" utility, the baud rate must match the baud rate of the TnitGDB (
port, baud ) or InitGDBNoWait ( port, baud ) function call in your application code.

" Run Configurations *
Create, manage. and run configurations é—;
TEX | = MName: | Mod5441xFactoryApp |
type filter text Project | 9= Arguments| B Environment | %5 Debugger| &2 Source| & Commeon
[E] C/C++ Application Praiect:
@ Launch Group L=
v MetBurner Launcher | Mad3441xFactoryApp | Browse
Mod3441xFactoryApp Target IP:
[101.1.86 || search
Appl Revert
Filter matched 4 of 9 items EEY —
'f?:' Run Close

When you click on the "Run" button, the dialog box will close, the application will be compiled, and a download to
the hardware target will commence. From this point forward, you can just click on the green circular "Run" button
to execute a download. Try it now and verify the download executes properly.

If you wish to see the boot sequence, you can connect a serial cable to the debug serial port, and run the MTTTY
serial terminal program. You will see the boot messages appear after each successful application download.
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6 Creating Projects in Locations Other Than the NBEclipse
Workspace

The previous section created a new project in the NBEclipse workspace. In this section, we will create a project in
an existing directory with source code files already present. The procedure is essentially the same as before except
without the step on importing the source code.

When a project is created in an existing directory structure:

1. All recognized source files will automatically be included and built. Recognized files are those with . c,
.cpp, and . s extensions, as well as any files in a directory named html. You do not need to explicitly
tell NBEclipse which files are to be built.

2. The "Project Explorer" window on the left side of the IDE works the same as the Windows File Explorer; it
will show all the files in the directory. This window does not represent which files are to be built for a
project — the files included in the build are all recognized source code files. If for some reason you have a
source code file in the directory that you do not want to include in the project build, then you will need to
right-click on the file name, select "Properties” in the pop-up menu, select "C/C++ Build" in the pop-up
dialog box, check the box "Exclude from build", and then press the "OK" button.

We will create a project in the existing \nburn\examples\MOD5441X\MOD5441x-FactoryApp directory
as an example.

6.1 Cleaning the Project Directory

NBEclipse uses a make utility to manage projects that will attempt to build all files in your project directory. All
non-source code files, including .o, .elf, .map, .mk, .dev, and the generated htmldata.cpp files must be
removed from the existing project directory so that they will not interfere with the build. NBEclipse will store all
output files similar to these in project subdirectories named Release and Debug corresponding to the build type
preformed.

6.2 Creating the NBEclipse Project

The first step is to create an NBEclipse project. The project will store the settings for building the application and
managing the build process. We can include the source code files from the example once the project is created.

From the NBEclipse main menu select: File » New » Project...

f‘ MetBurner - NBEclipse IDE - Release 2.7.6
File Edit Mavigate Search Project MBEclipse Run Window Help
MNew Alt+Shift+M » % Project... F;v
2rEn A £ Other..  Ctrl+N l
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+5
Save A
Save All Ctrl+Shift+5
Revert
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The "New Project" dialog box will appear.

There are various options available, but the only valid options for

development on your NetBurner device are under the "NetBurner" option. Choosing anything under "C" or "C++"
will not generate a compatible project for your NetBurner platform. Select “NetBurner Project” to continue.

L;'V‘ Mew Project

Select a wizard

Wizards:
type filter text

= General
= C/C++
w [ MetBurner
MetBurner Project

< Back

Einish Cancel
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Clicking "Next" will bring up the "C++ Project” dialog box. Note that even though it says "C++", it can manage C
files as well. In the image below, we have typed in the project name "Mod5441xFactoryAppLocation” because that
is the name of the example application, and we also want to distinguish it from the existing example when including
the files into the NBEclipse workspace.

This time, we will uncheck the "Use default location™ checkbox so we can select the existing directory location of
the source files. We have unchecked the box and used the "Browse..." button to navigate to the directory location of
the example source code.

' C++ Project d x

C++ Project p—

1 Directory with specified name already exists,

Project name: | Meod34d xFactoryApplocation

[] Use default location

Location: | Chnburnexamples\MOD344 1 X0MOD 544 1 x-Factory&pp Browse...
Project type: Teclchains:
<» MetBurner Device Executable MetBurner Device

<» MetBurner Device Library
= Makefile project

Show project types and toclchains only if they are supported on the platform

-

P
k‘?,' < Back Mest > Finish Cancel

Click "Next" to move on to the "Select Configurations" dialog box. Make sure "Release" and "Debug" are checked
for configurations. Click "Next" to proceed. Specify your target NetBurner platform and IP Address. Click Next to
continue. Once you're at the "NetBurner Project Options" dialog box, leave all boxes in the "NetBurner Application
Wizard" section unchecked. Clicking "Finish" will complete the project creation.

NBEclipse will automatically import the source files and attempt to build the project. You will then need to create a

"Run" configuration once your project builds successfully as described in Section 5.1.2 in order to download the
application to your NetBurner device.
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7 Removing an NBEclipse Project from an Existing Project Directory

The following procedure is used to remove an existing NBEclipse project while protecting your source code files. If
you wish to create a new NBEclipse project in a location where an NBEclipse project already exists, then the
following procedure must be taken before attempting to create the new project.

1. Navigate to the project directory with Windows Explorer.
2. Remove the following directories and files beginning with a ‘.’ .settings, .cdtbuild,

.cdtproject, .nbbuild, .project, etcetera.
3. Remove the subdirectories named Release and Debug.
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8 Debugging with NBEclipse

Only a few additional steps are needed to begin debugging once you have an NBEclipse project and "Run"
configuration that can successfully build and download your application. To debug an application, we will need to
do the following:

Verify the NetBurner hardware is set up and communicating properly.

Add debug capability to the application source code (an include preprocessor directive and function call).
Create a "Debug" configuration to build the debug version of the application. This is similar to the "Run”
configuration™, but includes information required for the debugger.

Launch the debugger.

8.1 Setup on Network Platforms

The communication interface between NBEclipse and network-enabled NetBurner platforms is the Ethernet
connection, which will require knowing the IP address of your target platform. This is set up via the "Debug"
configuration. If you do not have it set up already, then please refer to Section 5.1.2 on how to do this.

Network debug checklist:

8.1.1

The NetBurner hardware device is powered on and can communicate with your computer.

Start the MTTTY utility and verify that serial communication is able to take place on the NetBurner
hardware debug serial port.

You can communicate with the NetBurner hardware with a web browser or the ping utility. Both the PC
and NetBurner device must have correct network configurations to proceed.

The "Debug” configuration has the correct IP address of your NetBurner hardware in the "Host name or IP
address" field.

Connecting Directly from a PC

If you are connecting your NetBurner device directly to your PC, then you will need to configure static IP addresses
for both the PC and NetBurner device. You can use the IPSetup tool to configure the NetBurner device.

To configure the PC (the following lists steps for a Windows environment):

Open the “Control Panel” via the “Start” menu

Select the category "Network and Internet”.

Select “Network and Sharing Center” from the choices listed.

Click on the appropriate network connection listed by “Connections” and select "Properties™ from the pop-
up menu.

In the pop-up properties dialog box for the network connection you selected, select "Internet Protocol
Version 4 (TCP/IPv4)" from the "This connection uses the following items" listbox, and then select the
"Properties" button.

Specify static IP and subnet mask addresses in the "Internet Protocol Version 4 (TCP/IPv4) Properties"
dialog box (see example below). The IP and mask addresses of the PC and your NetBurner device must be
on the same subnet.

Warning: You should not use the "Alternate Configuration' tab setting (this tab only appears when
"Obtain an IP address automatically" is selected); this will cause the PC to continuously send out DHCP
request broadcasts that will interfere with the debugger connection.
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Internet Protocol Version 4 (TCP/IPwd) Properties >
General

‘You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your netwark administrataor
for the appropriate IP settings.

(") Obtain an IP address automatically
(®) Use the following IF address:

IP address: [w.1.1 .20 |
Subnet mask: | 255.255.255. 0f |
Default gateway: | |

Obtain DMS server address automatically

(®) Use the following DNS server addresses:

Preferred DMS server: | . . . |

Alternate DNS server: | . . . |

[Jvalidate settings upon exit Advanced...

Cancel

8.2 Setup on Non-Network Platforms

The communication interface between NBEclipse and non-network NetBurner platforms is a serial port connection.
You must have two serial ports available to use the debugger: one to download the application code and the other
for debugger communication. When we created the "Debug™ configuration in Section 5.1.2, you selected "Speed
Serial™ as the connection type. You will need one serial connection between the PC and NetBurner device to
communicate with the NBEclipse debugger. If you have two serial ports, then you can run MTTTY as well to
monitor the application output, which defaults to serial port 0 on the NetBurner device.

NetBurner Eclipse Getting Started Guide Page 31



NetBurner has created a fast serial communication utility called "Speed Serial Debug". Before attempting to debug
on a non-network platform, start the utility from the NBEclipse main menu:

NBEclipse » Speed Serial Debug

When the dialog box appears, select the PC serial communications port you wish to use and the baud rate (the baud
rate will need to match value specified in the debug function call of your application, which will be explained in the
next section). The network port should default to "2159"; enter this value if it isn't already in the textbox, and then
click on the "Connect" button. You will receive an error if some other application (such as MTTTY) is using the
same serial port.

e Verify the NetBurner hardware device is powered on and can communicate with your computer.

e Start the MTTTY utility and verify serial communication can take place on the NetBurner hardware serial
port. An easy way to do this is to press the reset button on the NetBurner device and verify that the start-up
messages appear.

e Start the "Speed Serial Debug" utility and configure it to use your second serial port; then click on
"Connect".

We recommend the Cables Unlimited USB-to-serial adapter (USB-2920) product if you need to add a second serial
port. It is usually available for less than $11 (US) and requires no special drivers on the Windows OS.

8.3 Adding Debug Capability to Your Application

The NetBurner example programs that contain the text "FactoryDemo" or “FactoryApp” in the project name should
already have the debug code in the application’s main.cpp file. This section explains what code is required for
debugging and how it functions.

The preceding sections covered items related to the NBEclipse configuration, which also included making sure the
application is configured to accept a debugger connection. For both network and non-network platforms, the
requirements are the same: include the debugger header file and call a function to listen for the NBEclipse debugger
connection.

8.3.1 Network Platforms
Include the NetworkDebug.h header file and one of the following two functions:
InitializeNetworkGDB and Wait () or InitializeNetworkGDB (). The difference between the two

is that the "wait" version will block until the debugger connects; the "non-wait" version will start running
immediately and is the recommended method. A sample code snippet is shown on the next page:
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#include <NetworkDebug.h>

[117777777777777777777777777777777777777777777/77777777777777777777777
// UserMain

//
void UserMain( wvoid *pd )
{
InitializeStack(); // Initialize TCP/IP stack

if ( EthernetIP == )
{
iprintf( "Trying DHCP\r\n" );
GetDHCPAddress () ;
iprintf ( "DHCP assigned the IP address of: ")
ShowIP( EthernetIP );
iprintf ( "\r\n" );
}

#ifdef DEBUG

InitializeNetworkGDB () ;
#endif // DEBUG

OSChangePrio( MAIN PRIO ); // Set task priority to default (50)

// Remaining code...

Some important points to note on the above code are:

1. The #ifdef and #endif preprocessor directives are there so the function call will only be present for
debug builds of the application.

2. The initialization occurs after the DHCP service. Otherwise, the device would not have a valid IP address
and the debugger could not connect.
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8.3.2 Non-Network Platforms

Include the gdbstub.h header file and one of the following two functions: InitGDBStubNoBreak () or
InitGDBStub (). The difference between the two is that InitGDBStub () will block until the debugger
connects. The "NoBreak™ version will start running immediately and is the recommended method. A sample code
snippet is shown below:

#include <gdbstub.h>

LIS TTT7 7077707777777 7777777777777 7777777777777 7777777777777 77
// UserMain
//
void UserMain( void *pd )
{
//
// The following function calls will initialize two of the three
// UARTs to a default baud rate of 115,200 bps, 8 data bits, 1
// stop bit, and no parity. There are other serial functions that
// specify additional parameters. Serial ports are numbered 0, 1,
// and 2.
//
SimpleUart( 0, SystemBaud );

#ifdef DEBUG
InitGDBStubNoBreak ( 1, 115200 );
#endif // DEBUG

// Remaining code...

NetBurner Eclipse Getting Started Guide Page 34



8.4 Running the Debugger

To start a debug session, click on the downward pointing triangle next to the debug icon on the tool bar as shown in
the red circle below and select Debug Configurations... Select the debug configuration from the popup that
was created in Section 8.1 or 8.2 depending on your module, and hit the button labeled, “Debug”. After running the
debugger the first time, you can click on the icon of the small bug to replay the last run debug session.

" NetBurner - Mod5441xFacteryApp/main.cpp - NBEclipse IDE - Release 2.7.6 - 0 X
File Edit Source Refactor Navigate Search Project NBEcipse Run Window Help
i~ Glm il ZBenl g-@-E-@- B0 &I er o
| [ NetBurner (no launch history)
[ Project Explorer 3% = 0 ||[g maincpp i3 Debug As 5 = O || 5= Outline 2 =0
BS < * Revision: 2.7.6 * @ugc‘,nﬁgw&(® . AR o % T
125 ModS441xFactoryApp L. Organize Favorites. U predefh
4 Binaries o stdic.h
5l Includes o ctypeh
& html o sting.h
(= Release o startneth
[d] ftps.cpp ' autoupdateh
[£] main.cpp ® = dhcpclienth
[ SimpleAD.cpp * use this program 5 3 5 : W ethemeth
[] SimpleAD.h = networkdebug.h

(€] webfunes.cpp
[8 webfunes.h

o teskmonh
o teph

o udph

o serislh
ffs_fat/multi_drive
sim5441xh
webfuncs.h
MAX_EFFS_ERROR(
MMC_OFF_BOARD
MMC_ON_BOARD
AppName : const ¢
EffsErrorCode : cha
UserMain(void*)
OSDumpTCBs{voic

o
o
u
#
#
#
oc
=
#
#
4 dEnetfvoid) : void
£+
£+
=
#
#
®
®
.
.
°
°
°
®
®

ShowArp(void) : vc|
ShowCounters(voil
DumpTepDebug(ve
EnableTcpDebug(V
FTPServerlnit(int)

processPing(char’)
doManfTest(void)
showEthemnetlinks
displayEffsErmorCoc
doSingleMemCard
doDualMemCardTy
displayMenu(void)

#include "predef.h”
#include <stdio.h>
#include <ctype.n>
#include <string.h>
#inclnde <startnet.h>
#include <autoupdate.h>
#inclnde <dncpclient.h>
#include <ethernet.n>
#include <networkdebug.h>
#inclnde <taskmon.h>
#include <tcp.h>
#inclnde <udp.n>
#include <serial.n>

processCommandi
UserMain(void*)

#include <effs_fat/multi_drive mmc_mcf.h> v
< >
7 NEFind 57 | ¥ NECanfig ¢ = 0|/ B Console 52 | [£ Problems| & Tasks O 3B EHE|ltB-rg-=0
Platform 1P Address MAC Address Application CDT Build Console [Mod5441xFactoryApp]
[E] Mops441x 100170 00-03-F4-07-5D-28  nnn Used 191313 bytes of 33292 "
[ setee 10.1195-DHCP  00-03-F4-03-3-3  A2DWeb Used 551442 bytes of 67108095 available Tam (1.42%)
[E] MODS41X 101185 DHCP  00-03-F4-0A-01-B0  AppWizard NNDK release tag versio 6

Build complete for project ModSé4lxFactoryApp
Time consumed: 1664 ms.

Writable Smart Insert 1:1

NBEclipse should rebuild the application as a debug version, and then attempt to download the debug application
build into your NetBurner device and make a debug connection.
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Once the debugger connects, a dialog box may appear, asking if you would like to switch to the "Debug"
perspective. After accepting, NBEclipse will switch to the "Debug" perspective, which provides windows for RTOS
thread information, variable watch windows, etcetera. A screenshot of this perspective is shown below.

The "Debug" tab shows the RTOS threads and their status. Detailed thread information is only valid when the
processor is stopped at a breakpoint. The display below shows the thread number, priority, name, and status.
Any threads you create for your application will be named "User". The icons to the right of the "Debug" tab (before
the first separator) are: Remove All Terminated Launches, Restart, Resume, Suspend, Terminate, and Disconnect.
You must have a debug session selected in order to terminate a debug session (in this example, it is the "NetBurner
Standard Debugger"), and then click on the terminate icon. The "Variables" tab will display the variables in scope at
the time a breakpoint is reached. The "Edit" window currently has only the main. cpp file open. This is where
you will set breakpoints and edit code.  The "Outline" window provides a view of the project functions and
resources.

If you look just above the "Debug" tab, you will see two perspective selection buttons. We were in the "C/C++"
perspective before the debug session was started. You can change perspectives at any time. For example, if you
prefer to edit code in the "C/C++" perspective, then you can select it and make any changes you find necessary in
the debug session.

Breakpoints are set by double-clicking in the far-left gray-colored margin next to the source code lines in the edit
window (currently displaying main. cpp).

.+ Debug - Mods44TxFactoryApp/main.cpp - NBEClipse IDE - Release 2.7.6 - o x
File Edit Source Refactor Davigate Search Project NBEclipse Run Window Help
i~ glE @ TZB OR H-0r @ [ Do
[ %5 Debug [ NetBurner
35 Debug i 0 m | | i+ 3| €2 7 = O 0= variables 12 | %6 Breakpoints 2] & [SR=)

Med544TxFactoryApp [NetBumer Launcher]
&P NetBurner Standard Debugger (10/3/16 4:37 PM)
@ Thread [7 Prio( 48) :FTPD] (Running)
5@ Thread [6 Prio( 45 ) :HTTP] (Running)
@ Thread [5 Prio( 38) :Enet] (Running)
@ Thread [4 Prio( 39 :IP] (Running)
@ Thread [3 Prio( 40):TCPD] (Running)
& Thread [2 Prio( 50) :Main] (Running)
@ Thread [1 Prio( 63) ldle] (Running)
i Ci\nburmi\gec-m8k\bin\m6sk-elf-gdb (10/3/16 4:37 PM)
o C:\nbum\NBEclipse\workspace\ Mod3441xFactoryApp\Debug\ Mod3441xFactoryApp.elf (10/3/16 4:37 PM)

[9 main.cpp & = 0|/ 5= outline 22 BRseo%”"0
~ = predeth ~

U stdich

* The main task o cypeh

# o stringh
~ void UserMain(void *pd)  starineth
N = autoupdateh
/ Initialize TCB/IP stack = dhepclienth
InitializeStack(): = ethemeth
= networkdebug.h
:r (EcheznetIF == o) U taskmonh
iprintf ("Trying DHCE...\r\n"); :J tep.h
GetDHCPAddress () ; H udph
iprintf ("DHCP assigned the IF address of: "); | serialh
ShowTP (EthernetIp) ; o effs fat/multi_drive_mmc_mcfh
iprintf(Mz\n") ; o simsddixh
) = webfuncsh
else # MAX_EFFS_ERRORCODE
1 # MMC_OFF_BOARD
iprintf("Static IP address: "); v # MMC_ON_BOARD
®° AppName: const char v
B Console 32 | ¥ Tasks| [ Problems | (3 Executables ] | E S8 +B~5-=6

Mod544TxFactoryApp [NetBurner Launcher] C:\nburn\ NBEclipse\workspace\Mod544 TxFactoryApp\Debug\Mod5441xF actoryApp.elf (10/3/16 4:37 PM)

0® Writable Smart Insert 432:25
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8.5 Step by Step Debug Session

In this section we will create a simple application using the Application Wizard, add a few lines of code, and use the
NBEclipse debugger to step through the application. The procedure for using the Application Wizard is nearly
identical to the procedure we used to import a project. The difference occurs in the final step, where we will select
Application Wizard options to generate source code rather than creating an empty project.

8.5.1 Create an Application with the Application Wizard

From the NBEclipse main menu, select: File > New > Project...

‘-'5" MetBurner - MBEclipse IDE - Release 2.7.6
File Edit Mavigate S5earch Project MNBEclpse Run  Window Help
Mew Alt+Shift+N > % Project... -
b F9 Other..  Cirl«N r
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+5
Save As...
Save All Ctrl+Shift+5
Revert

Select the "Managed NetBurner Project™ option:

" Mew Project O *

Select a wizard

Wizards:
type filter text

= General
= CfC++
~ [= MetBurner
MNetBurner Project

3 .
@_) < Back Met = Finish Cancel
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Name the project "AppWizard":

_;'V‘ C++ Project

m} X
C++ Project —
Create C++ project of selected type .
Project name: | AppWizard |
Use default location
Location: | ChnburnMBEclipse\workspace\AppWizard Browse...

Project type: Toolchains:

> NetBurner Device Executable
> NetBurner Device Library
= Makefile project

MNetBurner Device

Show project types and toolchains only if they are supported on the platform

® < Back Next > Cancel

Select the appropriate configurations

_;'V‘ C++ Project

Select Configurations

Select platforms and configurations you wish to deploy on

Project type: MetBurner Device Executable
Toolchains: MetBurner Device

Configurations:

%) Release Select all
% Debug

Deselect all

Advanced settings...

Use "Advanced settings” button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.

® < Back i Mext> Einish I Cancel
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Select your Target Platform/IP Address

‘;"" C++ Project

O >

NetBurner Platform Options p—
Set the platform options for the new MetBurner project.

Platform Configuration Options

A platform must be selected to finish this wizard.

Device Select (Autofill): Search

Target Platform: | MOD5441% V|

IP Address: [ 10.1.1.86
@ < Back Next » Einish Cancel
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Network platforms: In the "NetBurner Application Wizard" section of the dialog box, select the options shown in
the image below, and then click on the "Finish" button. NBEclipse will create the project and a file named
main.cpp that contains the source code for the options you selected in the application wizard.

;"1 C++ Project O *

NetBurner Project Options f—

Set the various options for the new NetBurner project.

MetBurner Application Wizard

If you would like NBEclipse to generate your project, please select your configuration ¢
Mot all options are avaiable for every platform

Options

AutoUpdate [ 5martTrap
Serialload WiFi

[~ DHCP [~ Network Debugging

[+] WebServer Serial Debugging

[ TaskScan

.i?"\ ..
CJ < Back Mext = Cancel
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Non-network platforms: In the "NetBurner Application Wizard" section of the dialog box, select the options
shown in the image below, and then click on the "Finish" button. NBEclipse will create the project and a file named
main.cpp that contains the source code for the options you selected in the application wizard.

#' Ce+ Project O x

MetBurner Project Options —

Set the various options for the new MNetBurner project.

MetBurner Application Wizard

If you would like MBEclipse to generate your project, please select your configuration ¢
Mot all options are avaiable for every platform

Opticns
AutcUpdate SmartTrap
Senialload WiFi
DHCP Metwork Debugging
WebServer : {
Task5can

.i?‘\ > =
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This is an image of NBEclipse after the application wizard has generated and built the project. Note that when a
new project is created, its main.cpp source file is not open by default. You will need to expand the "AppWizard"
project directory on the left side and double-click the file in order to open it in the edit window.

" NetBurner - AppWizard/main.cpp - NBEclipse IDE - Release 2.7.5 - O X
File Edit Source Refactor MNavigate Search Project NBEcipse Run Window Help
(il @i | P EAEBaW® @@ B0 & A~ eoro-
I © NetBurner
[ Project Explorer 51 = 0 || [& maincpp 23] = O || B Outline 23\ =8
B % = ﬁ?ncluda <predef.h> AR e %Y
v £ RppWizard: "f“"i“:a <szdio.hy U predefh
5 Binaries #include <ctype.n> o stdion

nclud #include <startnet.h> o "
) Includes e
" #include <autoupdate.h> ctyp

& Debug #include <dhepelient.h> U startneth

& html #include <NetworkDebug.h> = autoupdateh

(= Release W dhepclienth

[@ main.cpp o NetworkDebugh
extern "C" { ++ UserMain(void™) :
void UserMain(void * pd): @®° AppName: const ¢
} @ UserMain(void®) : \.

const char * AppHame="ZppWizard":

| void UserMain(void * pd) {
InitializeStack():
GetDHCPAddressIfNecessary () ;
0SChangePrio (MAIN_FRIO);
EnableAutoUpdate () ;
StartHTTP () ;

#ifdef DEBUG
InitializeNetworkGDB_and Wait():
#endif

iprintf ("Application started\n"):
int n = 0;
while (1) {

0STimeDly (TICKS_PER_SECOND) :

nte:
¥
¥
< >

7 NBFind 2 | 7 NBConfig = OB Console £ | [1 Problems| ¥ Tasks R Gl &8 tE~-i-70
Platform P Address MAC Address Application <terminated> AppWizard [NetBumer Launcher] CAnburn\gce-m68k\bin\m68k-cif-gdb (10/3/16.409 PM)

Bl Moossix 101470 00-03-FA0T-5D28  mnn Current lenguage: auto; currently c++

[ ssLee 1011195 DHCP  00-03-F4-03-93-3F  A2DWeb Current language: auto; CUrrently c

[E] MoD3441%  10.1.1.86 - DHCP 00-03-F4-0A-01-B9  AppWizard kil

O Ditems selected
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Network platforms: The source code listing in main.cpp is shown below.

#include <predef.h>
#include <stdio.h>
#include <ctype.h>
#include <startnet.h>
#include <autoupdate.h>
#include <dhcpclient.h>
#include <NetworkDebug.h>

extern "C" {
void UserMain (void * pd);

}
const char * AppName="AppWizard";

void UserMain (void * pd) {
InitializeStack();
GetDHCPAddressIfNecessary () ;
OSChangePrio (MAIN PRIO);
EnableAutoUpdate () ;
StartHTTP () ;

#ifdef DEBUG

InitializeNetworkGDB and Wait();
#endif

iprintf ("Application started\n");

while (1) {
OSTimeDly (TI CKS_PER SECOND )
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Non-network platforms: The source code listing in main.cpp is shown below.

#include "predef.h"
#include <stdio.h>
#include <ctype.h>
#include <basictypes.h>
#include <serialirg.h>
#include <system.h>
#include <constants.h>
#include <ucos.h>
#include <SerialUpdate.h>
#include <smarttrap.h>
#include <gdbstub.h>

extern "C" {
void UserMain (void * pd);

}
const char * AppName="AppWizard";

void UserMain (void * pd) {
SimpleUart (0, SystemBaud) ;
assign_stdio (0);
OSChangePrio (MAIN PRIO);
EnableSerialUpdate() ;

#ifndef DEBUG
EnableSmartTraps () ;
#endif

#ifdef DEBUG

// : Input correct port and baudrate below
InitGDBStubNoBreak ( int port, int baudrate );
#fendif

iprintf ("Application started\n");
while (1) {
OSTimeDly (20) ;
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8.5.2 Edit the Application Wizard Source Code

To make the debugging session a little more interesting we will add a variable and increment it in the while loop.
Open main.cpp in the editor and add the code for the type int variable ‘n’:

int n ;
while

{

0
(1

)

OSTimeDly (
n++;

’

20 )

Non-network platforms: Modify the InitGDBStubNoBreak() function call to add the NetBurner device serial port

number and baud rate. Valid serial port numbers are 0, 1, and 2. Serial port 0 is used for stdin, stdout, and stderr by
default.

InitGDBStubNoBreak ( 115200

1, ) ;

8.5.3 Create Run and Debug Configurations

Click on the small, downward-pointing triangle next to the "Run" icon on the NBEclipse toolbar. Select the Run
Configurations... option from the drop-down menu. The "Run" configuration and "Debug" configuration
share the same set of tabbed dialog boxes, so you can configure them both at the same time. Create the run and

debug configurations as we did in Section 5: "Downloading Applications to NetBurner Hardware — Creating 'Run’
and 'Debug’ Configurations".

. NetBurner - AppWizard/main.cpp - NBEclipse IDE - Release 2.7.6 o X
File Edit Source R svigate Search Project NEEclipse Run Window Help
i< IR LY 'R M AN AR S Rl EASIE FE- R R X R e
|5 NetBumer 1 AppWizard
[ Project Explorer 53 = 0| [c) mainepp &3 s = 8|8 outline 2 =0
5 & V|| #include <predef.:l> " Runt ons AR o %Y
S AppWizard inalodefssbdioyh] Organize Favorites, o predefh
#include <ctype.n> o e
#include <starcmec.ns a N
#include <autoupdate.n> e
#include <dncpelient.n> El startnet
#include <NetworkDebug.h> U autoupdateh
U dhepclienth
2 NetworkDebugh
extern nCv ( £ UseiMain(void®)
void UserMain(void * pd): ®° AppName: const ¢
) o UserMain(void’)
const char * AppName="Appiiizard";
void UserMain(void * pd) {
InitializeStack ();
GetDECPAAdressITNecessa oy ():
0SChangePrio (MATN_PRIO) ;
EnableAutolpdate () ;
StartATTe();
#ifdet pESUG
InitiallzeNatworkaDB and Wait():
#endis
"Applicacion starcedinr);
int o= 0:
while (1) ¢
OSTimeDly (TICKS_PER_SECOND) ;
nres
< >
47 NBFind 52 | ¥ NBCanfig & = 0 |[ 2 Console 22 | (¢ Problems | & Tosks R% | GElEEEE +8-r5-78
Platform P Address MAC Address Application <terminated> AppWizard [NetBurner Launcher] Gi\nburn\gec-m68k\bin\mék-f-gdb (10/3/16 409 PM)
Emoosunx 101170 007028 Curent language: @uto; CUITeRtly ort
[=] seLe 1010195-DHCP 00-03-FA-03-03-3F  A2DWeb [urrent enguager aueer cummesniy e
[E]MODS&41X  101.186-DHCP  00-03-F4-0A-01-B9  ApplWizard ’"
o Witable Smartnsert | 2:18
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8.5.4 Non-Network Platforms — Start Speed Serial Debug

If you are using a non-network platform, then start the "Speed Serial Debug" utility, verify configuration, and
connect. From the main menu:

NBEclipse » Speed Serial Debug

Note that when using the ""Speed Serial Debug' utility, you need two serial ports: one for code download and
one for debugging.

8.5.5 Launch the Debugging Session

Click on the "Debug" icon on the NBEclipse toolbar, which is to the left of the "Run™ icon in the picture below.
Since this is the first time we are starting this debug session, a dialog box will appear showing a list of debug
sessions. Select the debug configuration we just created in Section 8.5.3.

" NetBurer - App\Wizard/main.cpp - NBEclipse IDE - Release 2.7.6 - o e
File Edit Source Refactor Mavigate Search Project NBEclipse Run Window Help—
i~ Gl el @R Frard @ 9;;)0‘ @ 5 - LR R R R R -
i E NetBurner =
[ Project Explorer 23 =g main.cpp &3 = O|| B outline &2 =8
= <§> = #include <predef.h> AR o %7
&2 AppWizard #include <stdio.n> o predern
#include <ctype.h> o dion
#inclnde <startnec.h> u .
#include <aucoupdate.n> c ctypel
#include <dhcpclient.h> _‘ startneth
#include <NetworkDebug.h> i autoupdateh
4 dhepclienth
U NetworkDebug.h
extern "C" { ++  UserMain(void®)

void UserMain(void * pd); @®° AppName: const ¢
) ®  UserMain(void?)

const char * AppName="AppWizard";

void UserMain(void * pd) {
InitializeStack();
GetDHCPAddressIfiiecessary ();
0OSChangePrio (MAIN PRIO) ;
EnableAutoUpdate () 7
StartETTB();

#ifdef _DEBUG
InitializeNetworkGDB_and Wait () ;
#endif

iprintf("Application started\n");:
int n = 0;
while (1) {

0STimeDly (TICKS_PER_SEGOND) ;

ntts
< >
7 NBFind 52 | 7 NBCanfig & = O||E Console & | [EL Problems| & Tasks xR R EE s R
Platform 1P Address MAC Address Application <terminated: AppWizard [NetBurner Launcher] C:\nburm\gcc-m8K\bin\mb8k-elf-gdb (10/3/16.4:09 PM)
EIMoDssx 101070 00-03-F4-07-50-26  nnn z.ln:enc iangaagai auto: c.n:ranciy o+
[ seLee 101.1.195-DHCP  00-03-FA-03-03-3  A2DWeb CoTIeRR femeuaser smrer cumeesl e
E MOD5441X 10.1.1.86 - DHCP 00-03-F4-0A-01-B9 AppWizard -

Writable Smart Insert 311
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If the launch is successful, the "NetBurner" perspective wil

| change to the "Debug" perspective.

" Debug - AppWizard/main.cpp - NBEclipse IDE - Release 2.7.6

File Edit Source Refactor MNavigate Search Project NBEcipse Run Window Help
(il [@ | BB W® (B0 @
E¥ %5 Debug [F NetBumner

B oo

% &7 00 00 W &7 | BN

9= Variables 53 | @ Breakpoints | {%! Registers| @A Modules PRI L s

~  AppWizard [NetBumer Launcher]
~ & NetBurner Standard Debugger (10/3/16 4:09 PM)
5@ Thread [6 Prio( 45) :HTTP] (Running)
@ Thread [5 Prio( 38) :Enet] (Running)
@ Thread [4 Prio( 39 :IP] (Running)
@ Thread [3 Prio( 40) :TCPD] (Running)
@ Thread [2 Prio( 50) :Main] (Running)
& Thread [1 Prio( 63) Idle] (Running)
o Ci\nburn\gee-mBk\bin\m63k-elf-gdb (10/3/16 4:09 P
b

W ¢

M)

o

d.elf (10/3/16 4:09 PM)

PP

[© main.cpp &

85 Outline 37 o0

© void UserMain(void * pd) {
InitializeStack():
GetDHCPAddressIfNecessary () ;
05ChangePrio (MAIN_FRIO) ;
EnableAutoUpdate () ;
StartHTTP ()

#ifdef _DEBUG
InitializeNetworkGDB_and Wait();
#endif

iprintf ("Application started\n");
int n = 0:
while (1) {

0STimeDly (TICKS_PER_SECOND) :

predefh

stdioh

ctypeh

startneth
autoupdateh
dhepclienth
NetworkDebugh
UserMain(void®) : void
®© AppName : const char®
® UserMain{void®) : void

& Console 52 | & Tasks| [21 Problems| @ Exccutables| 0 Memory|

X% BBAESE #E--r5-=0

AppWizard [NetBurner Launcher] C: v d.eff (10/3/16 4:08 PM)
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8.5.6 Breakpoints and Stepping Through Code

Use the mouse to double left-click in the leftmost side area next to the source code line n++; as shown below. The
breakpoint should be reached quickly and the "Debug" perspective will update its windows and variables to display
the current state of the application.

The debugger control icons are shown inside the red oval. These icons will only be active when you have the
current debugging session selected, such as the "NetBurner Standard Debugger™ session shown in the "Debug" tab
window below.

The first active icon is the green "Resume” button. Click on it now and see that the application will run until it
reaches the same breakpoint again. The red square "Terminate" icon should only be used when you want to end
your debugging session.

The yellow arrows are for the "Step Into", "Step Over", and "Step Return™ functions from left to right, respectively.
These enable you to single step to the next line (step over), step into a function call (step into), or run until the
current function call returns (step return). Try clicking on the "Step Over" icon now and see that the debugger
position moves to the 0STimeD1y (20) source code line and the type int variable n increments by 1 (note that 20
ticks = 1 second).

.+’ Debug - AppWizard/main.cpp - NBEclipse IDE - Release 2.7.6 - 0o x
Fle Edt Source Refactor Navigate Search Project NBEclipse Run Window Help
mihd glm /BB O®R B0 @S N FH e
Y %5 Debug | I NetBurner -
35 Debug 12 < I ES -F{F:fj i+ 32| €5 7 7 0|t Varisbles 12 | O Breakpoints | 5 Registers | B Modules < B ¢ § ieg¥ =8

£

AppWizard [NetBurner Launcher] A || Name Value
&8 NetBurner Standard Debugger (10/3/16.4:02 PM) (Suspended) & pd D+00000000
P Thread [6 Prio{ 45 ] {HTTP] (Suspended) o n o
6 0SSched() ucos.c:475 0x4000cbb6
5 OSSemPend() ucos.c:800 0x4000d502
4 select() iosys.cpp:455 0:40026926
3 HitpMain() http.cpp: 183 Dxd0023c6e
2 TopOfStackKillfunction() ucosmefe.c:64 Dd0D0cded
1 <symbol is not available> 000000000
@ Thread [5 Prio( 38 :Enet] (Suspended)
P Thread [4 Prio{ 39 :IP] (Suspended)
P Thread [3 Prio( 40 :TCPD] (Suspended)
P Thread [2 Prief 50 ) :Main] (Suspended: Breakpeint hit.)
3 UserMain() main.cpp:31 040000560
= 2 TopOfStackKilfunction() ucosmce,ci64 0x4000c4c8
= 1 <symbol is not available> 0x00000000 v

[ main.cpp &2 = 0| 5 outline 22 ER o %~70
~ U predeth
~ void UserMain(void * pd) { o stdioh
- InitializeStack (); u ciypeh
GetDHCPAddressIfNecessary () ; ol startneth
u
u

0SChangePrio (MATN_PRIO) ; autoupdate.h
EnableAutoUpdate () ; dhepelienth
StartHTTP () : 2 NetworkDebug.h

++  UserMain(void*) : void
@° AppName : const char
® UserMain(void®) : void

#ifdef _DEBUG
InitializeNetworkGDB_and Wait ()
#endif

iprintf ("Application started\a"):
int n = 0;
while (1) {

0STimeDly (TICKS_PER_SECOND) ;

ne:
v
E Console 57 | &2 Tasks| (21 Problems| @ Executables| @ Memory - I EEEER -
AppWizard [NetBumer Launcher] C pp Deb d.eff (10/3/16 4:09 PM)
o Writable Smartnsert | 3111

8.6 Modifying Code and Restarting the Debugger

The most common way to make modifications and start a new debugging session is to:
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e Click on the red square "Terminate" button to end the current debugging session.

e Click on the "NetBurner" perspective button to reconfigure the view. Alternatively, you can make edits
right in the "Debug" perspective.

e Click on the "Debug" icon on the NBEclipse toolbar to download the modified application and start a new
debugging session.

8.7 The Variable Watch Window

The "Variables" tab watch window will automatically identify all local variables. These variables are updated each
time a breakpoint is reached. If you are in a function with large arrays of data and are stepping through the code one
line at a time, then you can decrease the amount of time it takes to execute a step by collapsing the nodes in the tree

control.

The screen shot below shows the nodes collapsed:

.+’ Debug - AppWizard/main.cpp - NBEclipse IDE - Release 2.7.6
File Edit Source Refactor Mavigate Search Project NBEclipse Run Window Help
wihd |G i@ Y EBEma™® -0~ @ FE o,
[ %5 Debug [ NetBurner
%5 Debug 2 i | 2 @ & 5| i+ 3| ¢ T = 0| Variables 12 | 9 Breakpoints | i Registers | B Modules 5 B | e §&

o Thresd [6 Prio{ 45 ) :HTTP] (Suspended) n/,\-[;m_;- Velue
6 0SSched() ucos.c475 0x4000cbb6 o \

5 0SSemPend() ucos.c:200 (x4000d502 [ é ::ﬁw \-‘ 333232232

4select() iosys.cppi435 (40026926 /

3 HitpMain() http.cpp:183 0x40023c6e /

2 TopOfStackKillfunction) ucosmefe.c:64 0xd0D0cdcd —

1 <symbol is not available> 0x00000C00

o Thresd [5 Prio{ 38 ) :Enet] (Suspended)

o Thread [4 Prio( 39 IP] (Suspended)

@ Thread [3 Prio{ 40 ) :TCPD) (Suspended)

@ Thread [2 Prio( 50) :Main] (Suspended: Breakpoint hit.)

3 UserMain() main.cpp:31 0x400005a6
2 TopOfstackKillfunction() ucesmefc.c:64 0d000cdcd
= 1 <symbol is not available> 0x00000000
P Thread [1 Prio( 63 :Idle] (Suspended)
W C\nburm gec-m68kbin\ mBk-elf-gdb (10/3/16 3:55 PM)
= Deb d.elf (10/3/16 3:55 PM)

vl G PP’

[& maincpp 3 | [E] 0SSched) at ucos.c: 475 = 6| Bz outline 53 LR o ®%~"0
. e CiGrrevsuten s . o predetn

GetDHCPAddressIfNecessary () ; -
0OSChangePrio (MAIN_PRIO) ; U stdioh
EnableAutoUpdate () ; U ctypeh
StartHTTE () : = startneth
= autoupdateh

#ifdef _DEBUG W dhepdienth
InitializeNetworkGDB_and Wait(); % NetworkDebug.h
#endif +  UserMain(void®) : void
®° AppName: const char”

iprintf("Application started\n”); ®  UserMain(void®) : void
while (1) {

char buffer[255];

buffer[0] = '\0';

0STimeDly (TICKS_PER SECOND) :

El Console £ &2 Tasks| (21 Problems| 3 Executables| @ Memory ET s EEEER =

AppWizard [NetBurner Launcher] C: pp! Deb d.elf (10/3/16 3:55 PM)

0% Writable Smart Insert 31:1
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The screen shot below shows the nodes expanded (scrolling down would show more variables):

.+ Debug - AppWizard/main.cpp - NBEclipse IDE - Release 27.6
File Edit Source Refactor Mavigate Search Project NBEChipse Run Window Help

i |@ i@ Y EEa@® -0 B Bt aro-
[ %5 Debug [ NetBurner
45 Debug 32 | T B

o Thread [6 Priof 45 ) :HTTP] (Suspended) "
6 0SSched() ucos.c:475 0x4000cbbb o pd
5 0SSemPend() ucos.c:800 (x4000d502 v bﬁ buffer
4 select() iosys.cppi455 0:40026926 o [ [0.00]
3 HittpMain() http.cpp:183 (x40023c5e - bufferl0]
2 TopOftackKillfunction) ucosmefc.c:64 d0D0cdc - buffar]
1 <symbol is not available> G00B00000 e buffarl2]
o Thread [5 Priof 38 ) :Enet] (Suspended) - buffer(3]
2 Thread [4 Priof 39 :IP] (Suspended) - buffer(d]
o/ Thread [3 Priof 40 ) :TCPD] (Suspended) - bufferls]
P Thread [2 Prio( 50 ) :Main] (Suspended: Breakpoint hit) o bufferl5]
3 UserMain( main.cpp:31 (x40000526
2 TopOfstackKillfunction() ucosmcfi.c:64 Oxd000cdcd
1 <symbol is not available> 0x00000000
o Thread [1 Prio( 63 :Idle] (Suspended)

W C\nburnh gec-m68K\bin\mo8k-elf-gdb (10/3/16 3:55 PM)
CRe op b Wizard. elf (10/3/16 3:55 PM)

i+ B[ € 7 = O|69= Variables 23\ ‘e Breakpoints | 4t Registers | = Modules

Value
000000000
0wd00ca27d

coocoooo

R e~ 70

GetDHECPAddressIfNecessary () ; =
0SChangePrio (MAIN PRIO) : | stdioh
EnableAutoUpdate () :

StartHTTE () ;
=1 sutoupdateh

#ifdef _DEBUG ®  dhepelienth

InitializeNetworkGDB_and Wait (): = NetworkDebug.h
#endif ++ UserMain(void®)
®° AppName: const char”

oid

d

iprintf ("Application started\n®); ®  UseiMain(void*)
while (1) {

char buffer[255]:

pbuffer[0] = "\0';

OSTimeDly (TICKS_PER SECOND) ;

B Console 23 | & Tasks| [ Problems| O Executables| 0 Memory| FEE RS

AppWizard [NetBurner Launcher] C: PP b ) d.eff (10/3/16 3:35 PM)

o® Writable Smartnset | 31:1
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8.8 Debugging System Source Files and Critical Sections

When you are debugging an application and step into a function that is not in your project directory, you will be

prompted to enter the source code path. For example, the main while loop for a demo program is shown below
with a breakpoint at 0STimeD1ly ().

L.cl main.cpp 2

=8
T O OTTECTTaCRTT
GetDHCPAddressIfiecessary ()
0SChangePrio (MAIN PRIC);
EnableAntoUpdate();
StartHTTE():

#ifdef DEBUG
InitializeNetworkGDB and Wait():
fendif

iprintf ("Application startedin™);
while (1)} {

char buffer[255];

buffer[0] = "M\O0":

05TimeDly (TICKS PER SECOND) ;

If you select the "Step Over" icon, the debugger will execute the 0STimeD1y () function and break on the iprintf()
line. If you select the "Step Into™ icon instead, the debugger will step into the 0STimeD1ly () function. If the
debugger does not know the location of the source code file, then it will display the following:

L€| main.cpp E OSTimeDly( at ucos.c: 537 &%

l:an't find a source file at "ucos.c”
Locate the file or edit the source lookup path to include its location,

View Disassembly...
Locate File...

Edit Source Lockup Path...

The source code locations of system files are listed below. Normally, you will only need to specify one of the first
two entries:

e Network platforms: \nburn\system
e Non-network platforms: \nburn\system nn
e Platform-specific: \nburn\<platform>\system

NetBurner Eclipse Getting Started Guide Page 51



In this example, we will specific the \nburn\system directory for our network-enabled platform. Clicking on the
"Edit Source Lookup Path..." button will display the following screen:

' Edit Source Lookup Path it

Edit the source lookup path —
Add, edit or remove source containers

Source Lookup Path:
1= Default Add...

Edit...
Remove
Up

Down

Restore Default

[]5earch for duplicate source files on the path

©

Click on the "Add..." button:

' Add Source x
Add a container to the source lookup path + v
An absolute path to a file in the local file system. %g

A
[ Compilation Directory

[=File System Directory

| Path Mapping

(== Program Relative File Path

= Project

g Project - Path Relative to Scurce Folders
= Workspace

[=-Workspace Folder

®

Select "File System Directory" and then click the "OK" button.
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When the "Add File System Directory" dialog box appears, click on the "Browse..." button and navigate to the
\nburn\system directory. Click on the "Search subfolders" checkbox, and then click the "OK" button.

" Add File System Directory et

File system folder e
Specify folder and whether subfolders should be searched

Directony:

| Chnburntsystem | Browse...

You will be returned to the "Edit Source Lookup Path" dialog box, and should now be able to see that the
\nburn\system directory has been added to the search:

" Edit Source Lockup Path >
Edit the source lookup path -
Add, edit or remove source containers
Source Lookup Path:
w [ system - Cnburn Add...
= debuglibrary - C\nburn’system
= lua - Chnburntsystem Edit..
= I'1|:J-|I.|EI.}CI"|"E|‘_'," - Chnburn'system Remove
= nbwifi - C\nburn’system
= webclient - Ch\nburn'system Up
== Default
Down

Restare Default

[] Search for duplicate source files on the path
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Clicking on the "OK" button will return you back to the debug session, and the source code for the system function
0STimeDly () will now be displayed:

@ main.cpp m =0

362void O5TimeDly( WORD ticks ) A

BYTE p:

UCOS_ENTER_CRITICAL () :
p = OSTCBCur—»0STCEPric:
if { ( OSRdyTbl[p »> 3] &= ~O0SMapTbl[p & O0x07] ) == O

71 OSRdyGrp &= ~0SMapTbl[p >> 3]:
¥

OSTCBCur->0S5TCEBDly = ticks:
UCOS_EXIT CRITICAL():

0SSched ()

-

This example is also interesting because the first line in the 0STimeDly() function is
UCOS_ENTER _CRITICAL(). If you attempt to step over the UCOS ENTER CRITICAL () line, then you will
be returned to the next source code line in UserMain () .

You may be able to place breakpoints inside a critical section, but you cannot step through a source code line
containing the UCOS ENTER CRITICAL() function.  The reason is that both the debugger and
UCOS_ENTER CRITICAL() need to set the processor status register. You can step through the 0STimeDly ()
function by setting a breakpoint after the UCOS ENTER CRITICAL () line and then click on the "Run" button to
execute to the breakpoint. Once the breakpoint is reached, you can single step through the function.

[€] main.cpp B ucos.c 52 =0
362void OS5TimeDly( WORD ticks ) :A:

BYTE p;

UCOS_ENTER_CRITICAL();
p = OSTCBCur—>0STCBPria:
if { ( OSRdyTbl[p »> 3] &= ~0SMapTbl[p & O0x07] ) == O

OSRAyGrp &= ~0SMapTbl[p >»> 3]:

¥

OSTCBCur->»05TCBDly = ticks;
UCOS_EXIT CRITICAL():
055ched ()

et

L R e =]

T

i
i
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Revision History

Date Revision Comments

30-Sept-2016 1.9 Initial release

20-Jan-2017 2.0 Updated screen shots

03-Aug-2017 2.1 Added notes on sharing projects between operating systems.
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